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Notes from my messy desk…

The WordPerfect Mac News is published monthly. Find us at: • ftp .wordperfect.com

• BBS (801) 225-4414 • CompuServe: Go wordperfect and check the Mac Software

Library. • AOL : Keyword wordperfect in the Help and Info Files section of the Software

L ib rary .  •  WWW :  h t tp: / /www.novel l .com:80/ServSupp/mac/macnews/i ndex.htm

Also  look for us on info-mac, u-mich, stanford, and more places all the time! 

• We’re sporting a new summer layout. Hope you like it. Even if you
don’t, write us at macmail@wordperfect.com and let us know.

• Edgy mobs have gathered outside WP headquarters, asking polite but
pointed questions about the next WordPerfect release and what new
features it will have. Don’t worry, a press release on the next version
is forthcoming. It’s not in this issue, however. When it breaks, we’ll
be there to let you know what’s going on. Keep watching.

• One more time: Our WWW address has changed. It is now 
ht tp: / /www.novel l .com:80/ServSupp/mac/macnews/index.htm
Please change your pointers accordingly. Okay, if you’re reading this,
you’ve found us one way or another, but I thought I’d mention it.

• Thanks for your letters and feedback. Keep them pouring in. 
-- Daniel  
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You can reach us by e-mail at macmail@wordperfect.com, or by fax
at (801) 222-6980. We welcome your comments, feedback, tips &
tricks, and questions. Due to the sheer volume of mail we receive,
you may not get a personal reply. If you need support for a
WordPerfect product, use the support number in your User's Guide.

• Hello, I just saw your WordPerfect Mac News for June ‘95. I really enjoyed what I saw and

could read. Where can I find Envoy Viewer? I looked for it in the WordPerfect Mac files on CIS
and couldn’t find it. -- Dian Cuendet-Lewis  

We used to send the news as a stand-alone application, but that made the document rather
large. Now there’s the Envoy Viewer, which you’ll need to view the N e ws . Get it from
ftp.wordperfect.com in the folder / pub/wpapps /mac/envoy. The file name is edvmac.hqx.
And now that the News is in Envoy format, the files are tiny. For Envoy info and ordering,
call (800) 321-4566.

• Last month we mentioned that straight quotes (' & ") are best to use when you’re referring
to feet and inches, where smart quotes (‘ & ”) would be incorrect. Paul Schreiber responds:

Actually, real feet and inch marks (prime marks) are Option-4 and Option-comma in the
Symbol font.

That’s true, and they look very good. If you’re striving for that extra
dash of authenticity, and you don’t mind the extra step, use ‘em.
Keep in mind, however, that the Symbol font is larger than most
fonts, so using it tends to tweak out the line height.

• I realize it’s too late to submit a trick for the contest from the May WP Mac News (from the

zoomed text on Page 12), but, having just found a trick I can't find in the WP 3.1 manual, or in
the online help, I figured why not share it.

If you double click a word (i.e., select it), hitting Command-G will find the next selection of that
word. This is probably printed somewhere, but what the heck. -- Scott Rothstein

• Every so often I’ll be editing some text, and 1/2 of the screen display disappears. I am usually

able to repaint the screen by hitting the up scroll bar. -- Ken Sutin

Here’s a time-honored tip that has helped this problem.

Go into System Folder/Preferences/WordPerfect, and trash the Preferences (USA) file.
Sometimes this file gets damaged. When you re-launch WordPerfect, a new one will be
created. This should alleviate the redraw problem.

• I have WordPerfect Works running on my old PowerBook 100. It is the ideal full-feature word-

processor (+drawing etc.) for this (and other) low spec. machines. Are there any plans to
update WordPerfect Works?

Also, I use Microsoft Word on my Mac at work; is there a side-grade-to-WordPerfect 3.1 option
available? -- Andy Sheppard

No news on a new WP Works version yet, but you can get a competitive 
upgrade to WordPerfect from any word processing program for a 
mere $99. Call us at (800) 228-2875 for orders or info. 
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Using Paragraph Numbering

I like WordPerfect’s Outlining feature, but I don’t always like having a new number appear
automatically every time I press Return. So I was pleased to find out that you can use Para-
graph Numbering without having to turn the Outlining feature on.

Just write a macro that goes:

Set  Paragraph  Leve l  (Automatic)

Assign it to a keystroke, or a custom macro button on your Button Bar, if you like.

Now whenever you run the macro, an automatic paragraph number will be placed at the
insertion point. The numbers will update themselves automatically, and they’ll know to
change levels if there’s a tab in front, just like in Outlining.

This macro is especially useful when you want to put automatic numbers before items in a list
you’ve already created.

(See “Using the Macro Editor to Create Macros” on page 418 of your 
WordPerfect 3.1 User’s Guide if you need help getting started on this 
macro.)

That Sum Button

If you have a chunk of a table highlighted (including more than one

column and row), and you click the Sum Button  on the Table/Math
Bar, it will add up the individual columns  (going down). 

If, however, you hold down the Option key and click the Sum button 
with the same chunk highlighted, it will add up the rows (going across).

Cropping

You probably already know that you can click on a graphic and drag the handles to re-size it.
But if you hold down the Command key (Option key for v.3.0 and earlier) while dragging the
handles, it does something called Cropping. Here’s how it works.

Perhaps you have a graphic that’s not fitting right on the page. Click on the graphic to make
the handles appear, hold down the Command key, and drag to make the box smaller or larger.

This only changes the size of the containing
box - not the graphic itself. 

If you Command-drag the graphic itself, it
moves the graphic around within the box
without moving the 
actual box itself.  
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by John Rethorst

No. 6: How to Automate Extensive Formatting

Now that we’re past the basics, this column will be more condensed, just to fit more value
in, and go a little faster. Don’t worry – I won’t make use of anything I don’t explain at the
time or haven’t covered in a past issue. 

Text Formatting

Doing a large amount of identical formatting is a great job for a macro. Consider a glossary
or dictionary (or catalog or handbook) where you want each word or phrase being defined
in bold, and the description in plain text, like this. 

geek: person whose life has been taken over by computers, and who can’t think about
anything else. 
hacker: person who’s very productive with computers, and who can 
use them to great advantage. 
twelve-step program: means to achieve freedom from something 
addictive and debilitating, such as computers. 

One way to do this would be to select bold every time you started a new definition, type the
word or phrase, and then switch back to plain text for the description. Dullsville and slow.
Another way would be to use a table, put words in one column and definitions in the
other, and bold the left column with one command. That would leave a lot of white space
if the definitions were long, though. You could then do table to text, after replacing all
colons with tabs, and then replace tabs with colons again, but this is starting to get compli-
cated. Can we just enter the whole thing in plain text, and have a macro bold every word
or phrase being defined? You bet. 

We need to pursue a little strategy to tell the macro what to do. First, let’s say that we used
double hard returns to separate paragraphs (I know that paragraph spacing is a better way,
but fewer people use that. It would be just as easy to design a macro for it, though). For
double hard returns, we’ll tell the macro to search forward until it finds the next pair of
hard returns. We then want to select everything between those hard returns and the next
colon, and change that selection to bold. 

Recording the first part

To start off, begin a macro recording, and call the Find dialog. Set the options to Direction/
Forward, Where/Document Only, Match/Text Only, Affect/Case and Text Only, Action
/Position After. From the Insert Menu, choose Hard Return twice. 
Click Find. It doesn’t matter if you find anything at this point.
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Switch to the macro editor; you should have this script. 

Find/Change Direction (Forward;No Wrap)

Find/Change Where ({Current Doc})

Find/Change Match (Partial Word;Case Insensitive;Alphabet Insensitive;CharRep

Insensitive;{Text Only})

Find/Change Action (Position After)

Find String (“[Hard Return][Hard Return]”)

Find

Abort When Not Found

which gets us to the double hard returns, positioning the cursor after them. Now, add
these lines to the script. 

Find/Change Action (Extend Selection)

Find String (“:”)

Find

Abort When Not Found

Attribute (On;Bold)

Right ()

to extend the selection to the next colon, use the Attribute command to turn Bold on for
the selection, and move the cursor one character to the right without 
selection, to deselect the text that’s been bolded. Try this on some 
sample text (possibly the sample definitions above, changed to plain 
text, copied and pasted a few times).

This works, but it’s rough. It ends with an error message when the macro can’t find either
double hard returns or a colon. To get it to repeat, you’d need to Set Repeat Count (Com-
mand-Shift-Clear) to at least the number of times you wanted it to repeat, then call Repeat
Count (Command-Clear), then run the macro. Let’s do better, by putting all this code in a
repeat loop, and deleting unnecessary lines. 

First, delete both lines that read “Abort when not found” and the last line, “Right ().” That
last line deselects the bolded text, a nice feature for a macro that runs once, since if a macro
or other action leaves anything selected, the user could inadvertently press another key
and erase the selection. We don’t want this line in a repeating macro, though, since each
line of code takes a certain amount of time to run. 

Then, add the line

Repeat

as the first line, and the line

Until (FindStatusFlag=0)

as the last line. FindStatusFlag is a flag just like SelectionFlag, which we learned in the
March issue. FindStatusFlag is on (or equals 1) if the most recent Find command found
something. So this macro runs until it runs out of things to find. 

Give this a try on your sample file. You would want to run it at 
the start of the definitions.
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Uh-oh. Bugs. 

Or would you? If the macro didn’t start soon enough in the file to find double hard returns
before the first word being defined, you’d miss bolding the word in that first paragraph. No
sweat, just put the cursor at the top of the file, preceding the paragraph or two of introduc-
tion (as in this column, above) and run the macro from there. Oops. That’s much worse.
What happened? 

The macro did just what you told it to do. It found the first set of double hard returns
(which, in this column, separate the two introductory paragraphs). It then found the first
colon, which comes after “geek,” and selected everything in between. Just what we thought

we wanted. 

At this point you, like all other Mac programmers, could say that you have something that
works well enough, as long as you keep its quirks in mind. This is called a “hack.” Or, you
can fix it and call it “elegant.” Up to you. Being WP users, let’s go for elegance. 

Let’s see. We need to tell the macro to find double hard returns, signifying the start of a
new paragraph, and then to look at that paragraph, to see whether it has a colon in it. If so,
we can assume it’s a definition. If not, we’ll have the macro move on to the next para-
graph. It’s true that there may be a colon in an introductory paragraph, 
but unless we use a special symbol between word and definition, we 
don’t have anything else to tell the macro to look for. We’ll have the 
macro end when it can’t find any more double hard returns. 

This is best represented by a flowchart like
the one at right. Flowcharting is a great
way to conceptualize, design and trouble-
shoot macros. As we go along each month,
I’ll emphasize this way of thinking about
the programming process, and you’ll find
it helpful to flowchart your way through
variations on what you see here, and on
your own ideas. 

I’ll also start adding comment lines to
scripts. These lines start with a semicolon,
or have a semicolon after the command.
Anything following the semicolon is
ignored by WordPerfect when running the
macro. They just serve to clarify the code
to another user. Thus, 

Assign (Var02;Var02+1);this increments the value of Var02 by 1

has a descriptive comment after the command. You can also start a 
line with a semicolon, followed by equals signs, asterisks or whatever, 
as a separator – again, to make it easier to read.
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Now to the script. It makes two decisions now, both based on what it can find. So we’re
using FindStatusFlag twice, and thus don’t want a repeat loop to continue until
FindStatusFlag=0 – it may well equal 0 at several points in the macro, but we want the
macro to keep going. So we’ll add a Go command, which sends macro execution to a Label.
Big words? Here’s a quasi-macro example: 

If (Today=Saturday or Sunday)

Go (Party)

Else

Go (Work)

End If

;==============================

Label (Party)

Drink beer

Make merry

End Macro

;==============================

Label (Work)

Work hard

Make money

End Macro

so the If/Else test in the first five lines sends macro execution to either 
of two parts, Party or Work. The comment lines of equal signs just 
make the script easier to read. 

In our actual script, below, we’re using one label, “top.” WP goes right by it when starting, and
proceeds to search for double hard returns, as before. If it doesn’t find any (FindStatusFlag=0),
the macro ends, resetting the Find/Change options to the defaults. Otherwise, it positions the
cursor after the double returns, and selects that paragraph. Within the selection, it then
searches for a colon. If it finds one, it extends the selection – meaning that the selection now
reaches from after the double returns to the colon – and it makes that selection bold.

If it doesn’t find a colon, it moves the cursor left one character to deselect the paragraph with
the cursor at the start of it, so it will be able to see the double returns following that paragraph.
Then, with the Go command, execution goes back to the top of the script to start over. 

Compare this script with the flowchart above and see how they match up. 

Label (top)

;=================================================================

;ready to search for the next double hard returns

;=================================================================

Find/Change Direction (Forward;No Wrap)

Find/Change Where ({Current Doc})

Find/Change Match (Partial Word;Case Insensitive;Alphabet Insensitive;CharRep

Insensitive;{Text Only})

Find/Change Action (Position After)

Find String (“[Hard Return][Hard Return]”)

Find

If (FindStatusFlag=0); if there aren’t any more double returns

Find/Change Reset

End Macro

End If (continued)
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;=================================================================

;if we find a double hard return

;=================================================================

Select Paragraph

Find/Change Direction (Within Selection;No Wrap)

Find/Change Action (Extend Selection)

Find String (“:”)

Find

If (FindStatusFlag=1)

;==============================================================

;if we find a colon

;==============================================================

Attribute (On;Bold); bold all text between returns and colon

Else

Left ()

End If

Go (top)

Then copy and paste this script into your macro editor and try it out. Fun! 

This complexity of design will seem difficult at first. Don’t worry. It gets much easier with
practice, and you’ll find yourself designing macros like this to relax. 
Meanwhile, go through this column again, remember how difficult

If (SelectionFlag)

Beep

seemed in March, and realize how much you’re learning! 

For the adventurous reader, you can add an alert to tell the user when there are no more
hard returns. This isn’t essential, but feedback is part of good design and a nice feature of
the Mac interface. The alert line would be something like

Alert (“Your formatting is finished. Go back to sleep.”)

or whatever variant you’d like to spring on your SO or co-worker. Now the quiz. Where
do you put it? Hint – figure this out using the flowchart. I’ll have the answer next month,
so see you then. 

* * *

John Rethorst, author of Teach Yourself WordPerfect 3 for the Mac, thinks that if anyone
ever really explains it all, it will be done with macros.  

The contents of this article are copyright © 1995 John Rethorst.

All rights reserved. Used with permission.
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The macros described in this section are contained in a

WordPerfect file called “July Macros Read Me.” It was included

when you downloaded the WordPerfect Mac News. The file also

contains instructions for moving these macros to your Library,

as well as more detailed help and instructions for use.

Emboss by Daniel Midgley

This macro will take your text and change it into a cool
embossed graphic, much like the ones on this page.

All you have to do is highlight some text, and run the
macro. WordPerfect will do the embossing, and then display the message below:

Just choose Paste from the Edit menu, and
your embossed text will be placed in your
document.

Some tips: • The embossed graphic looks best
at larger sizes (24 and up).   • The bolder the
font, the better.

Acknowledgements to Tips and Tricks  mini-magazine by Image Club Graphics, and Macworld’s 

Macintosh Secrets  by Pogue and Schorr.

White Text/Black Background by Lane Johnson

This macro will change your regular text to “reverse text” -- white on black.

Use it to create striking effects.

This macro works in text mode and in graphics mode. You must first highlight your text,
or select the graphic object if you’re in the graphics mode.

Check the January issue of the WP Mac News for a Tip that relates to this macro.  

Are you a macro-maniac? Have you created a macro that you’ve found useful? 

Or do you have any ideas for a macro you’d like to see? We welcome 

your submissions and ideas. Just e-mail to macmail@wordperfect.com (fax & 

snail-mail addresses are on the back page) to get the details.
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Using WordPerfect’s Librarian by David Moulton

What’s a Librarian, anyway?

The librarian is the utility that Wordperfect uses to manage macros, styles, keyboards, and
button bars. It’s what you use to delete, rename, or move any of these items.

Using the Librarian

To access the Librarian, choose
Preferences from the Edit menu.
Then click the Librarian button. You
will see the dialog box at left.

The first item to notice in the figure above is the Resource pop-up menu at the upper left of
the dialog box. This is where you choose what you want to work with. If you pop this menu
up, the menu should contain Styles, Macros, Character Maps, Keyboards, and Button Bars. 

For now we’ll focus on Macros.

Choose Macros from the pop-up menu. You should find that a list of macros appears in the
left hand window of the dialog. These are the macros that are stored in your Library. 

If you do not find macros appearing, consult the document “WordPerfect Read Me” if you
have WP 3.1, or “Macros Read Me” if you have WP 3.0. These documents will explain how to
get the macros that ship with WordPerfect into the Library. They are located in the Documen-
tation folder.
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Moving Items

Let’s say you’ve created some macros in your Library, and you want to give them to a friend
who has WordPerfect. You’ll use the Librarian to do that. Let’s see how: 

1. With the Resource pop-up reading ‘Macros’, highlight a macro in the left hand window.
You will notice that the Copy button between the windows will be pointing to the right.

2. Click the Copy button. The macro should appear on the right.

You can Shift-click at the beginning and end of a series of macros to 
select them, or Command-click on specific macros to select them.

3. When you are done with that, click the Done button and close Preferences. 

4. Save the document to a floppy diskette.

When you have the disk at your friend’s Mac, insert it and open the file in WordPerfect.

We’ll perform the opposite procedure to get the macros into the Library of the other Mac.

1. Bring up the Librarian dialog (Edit/Preferences/Librarian)

2. Choose Macros from the Resource pop-up.

3. Highlight macros on the right, and copy them over to the left.
This will install these macros into the Library of the other Mac.

Using Rename

Click on the item that you want to rename. Click the Rename button. Type in the new name.
Click OK. It’s just that simple.

Deleting Items

Let’s say you created a set of macros or styles that you don’t use anymore, and you want to
delete them.

Just click on the item that you want to delete and click the delete button. WordPerfect will
confirm that you want to do this, and then remove the item.

I have used macros as an example in this article, because that is what 
most people use the Librarian to manage. You can also use these steps 
for any of the items that appear in the Resource pop-up menu.  
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How do I make characters with the diacritical marks in WordPerfect 

(for example, à, é, î, ñ, ö, and so on)?

The easiest way is to choose Symbols… from the Insert menu. (For version 2.1 or 2.0,
choose Character Map from the Font menu.) You’ll see a big list of all the characters in that
font, and you can click on them to insert them in your document. 

But you may soon find that you don’t want to stop typing to bring up the menu. There is a
faster way. You can use the so-called “Dead Keys.” This consists of pressing a keystroke
combination, and then typing the letter.

For a grave accent ( ` ), type option-`, and then type the character.

For an acute accent ( ´ ), type option-e, and then type the character.

For a circumflex ( ˆ ), type option-i, and then type the character.

For a tilde ( ˜ ), type option-n, and then type the character.

For an umlaut ( ¨ ), type option-u, and then type the character.

For a ‘c’ with a cedilla ( ç ), type option-c.

More information can be found in your Macintosh User’s Guide on 
page 250.

I’ve done my page numbers in a footer, but now I need to start renumbering my page

numbers. How do I do this?

Even though you’re doing the page
numbers through the footer, you still
need to go to the Page Numbers
dialog (Layout/Page Numbers) to set
the new page number (highlighted
here in green).

Leave the Position at “No Page
Numbers,” but change the number
and type, if you like.

Unfortunately I have to deal with Word 6.0 files, which I am unable to do since WP 3.1

only provides a filter for up to version 5.1 of Word. Is there a filter for 6.0 out there and if

so, where can I get it? -- James Kramer

There is such a filter. It’s available from the folks at DataViz, as part of their Easy Open
package. Call them for information. (203) 268-0030.

If you don’t want to use the DataViz filter, you’ll need to save the 
Word 6.0 file down to Word 5.1 format (or any other format 
WordPerfect can read). Then open it up from within WordPerfect.  
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We welcome your comments, suggestions, letters, etc.

• What did you like about the WordPerfect Mac News?

• What would you change about the WordPerfect Mac News? 

• What features would you like to see highlighted in a future issue?

• Which do you use?    o  Mac    o  DOS    o  Windows    o  UNIX    o  Other

• Where did you find the WordPerfect Mac News?

                                                                                                                                                              

• Do you use any other word processors? Which one(s)?

                                                                                                        

• On the Macintosh, would you describe yourself as…

o  A beginner o  A fairly proficient user o  A power user

• On WordPerfect, would you describe yourself as…

o  A beginner o  A fairly proficient user o  A power user

You can reach us by e-mail at macmail @ wordperfect.com, by fax at (801) 222-6980, or “snail mail” to WP Mac News, MS ORM

G-1512, WordPerfect/Novell Applications Group, 1555 N. Technology Way, Orem UT 84057-2399.

Send your letters, requests, ideas for features, and tips & tricks to us! We reserve the right to edit any material received for

content, clarity, and length. By submitting material to the WordPerfect Mac News, you agree to assign any and all rights, title,

and interest which you may have to your submission material and any work Novell Inc. derives from such submission material

to Novell Inc., unless otherwise specified.

The WordPerfect Mac News was created using WordPerfect 3.1 for Macintosh. The headings and the link buttons were

created using ColorIt!™ 2.3 by MicroFrontier, Inc. Then the whole thing was printed to WordPerfect Envoy. WordPerfect 3.1,

Document Experts, and WordPerfect Envoy are trademarks of Novell, Inc. ColorIt!™ is a trademark of MicroFrontier Inc. Apple

and Macintosh are registered trademarks of Apple Computers Inc. All other trademark names are the property of their

respective companies.

NOTICE PLEASE READ: You accept this information with the understanding that Novell, Inc. makes no representations or

warranties as to the suitability of this information for your particular purpose, and that to the extent you use or implement this

information in your own setting, you do so at your own risk. In no event will Novell, Inc. be liable for any damages, whether

consequential, incidental, or special, arising out of the use of or inability to use the information provided herewith. Copyright

Novell Incorporated ©, 1995. All rights reserved.

If you do print out the WordPerfect Mac News, please recycle it.   
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